Chapter 468

Equivalence Tests for the Ratio of Two Negative Binomial Rates

Introduction

This procedure may be used to calculate power and sample size for equivalence tests involving the ratio of two Negative Binomial rates.

The calculation details upon which this procedure is based are found in Zhu (2016). Some of the details are summarized below.

Technical Details

Definition of Terms

The following table presents the various terms that are used.

<table>
<thead>
<tr>
<th>Group</th>
<th>1 (Control)</th>
<th>2 (Treatment)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample size</td>
<td>$N_1$</td>
<td>$N_2$</td>
</tr>
<tr>
<td>Individual event rates</td>
<td>$\lambda_1$</td>
<td>$\lambda_2$</td>
</tr>
</tbody>
</table>

Dispersion parameter: $\phi$ (Negative Binomial dispersion)
Average exposure time: $\mu_t$
Equivalence ratios: $R_{Lower}$ ($R_{Lower} < 1$); $R_{Upper}$ ($R_{Upper} > 1$)
Sample size ratio: $\theta = N_2 / N_1$
Hypotheses

The equivalence test hypotheses are

\[ H_0: \frac{\lambda_2}{\lambda_1} \leq R_{\text{Lower}} \quad \text{or} \quad \frac{\lambda_2}{\lambda_1} \geq R_{\text{Upper}} \quad \text{vs.} \quad H_1: R_{\text{Lower}} < \frac{\lambda_2}{\lambda_1} < R_{\text{Upper}} \]

where \( R_{\text{Lower}} < 1 \) and \( R_{\text{Upper}} > 1 \).

For a given equivalence test with significance level \( \alpha \), a two-sided confidence interval with \( 100(1 - 2\alpha)\% \) confidence is typically used. \( H_0 \) is rejected if the confidence interval falls completely between \( R_{\text{Lower}} \) and \( R_{\text{Upper}} \).

Power Calculation

Zhu (2016) bases the power calculation on an equivalence test derived from a Negative Binomial regression model. The power calculation is

\[
\text{Power} = \Phi \left( \sqrt{\frac{N_1}{V_1}} \left( \log(\frac{\lambda_2}{\lambda_1}) - \log(R_{\text{Lower}}) \right) - z_\alpha \sqrt{V_0} \right) + \Phi \left( \sqrt{\frac{N_1}{V_1}} \left( \log(R_{\text{Upper}}) - \log(\frac{\lambda_2}{\lambda_1}) \right) - z_\alpha \sqrt{V_0} \right) - 1
\]

where

\[ V_1 = \frac{1}{\mu_t} \left( \frac{1}{\lambda_1} + \frac{1}{\theta \lambda_2} \right) + \frac{(1 + \theta)\varphi}{\theta} \]

and \( V_0^- \) and \( V_0^+ \) may be calculated in any of 3 ways.

**\( V_0 \) Calculation Method 1** (using assumed true rates)

\[ V_{01}^- = V_{01}^+ = \frac{1}{\mu_t} \left( \frac{1}{\lambda_1} + \frac{1}{\theta \lambda_2} \right) + \frac{(1 + \theta)\varphi}{\theta} \]

Using Method 1, \( V_0^- \), \( V_0^+ \), and \( V_1 \) are equal.

**\( V_0 \) Calculation Method 2** (fixed marginal total)

\[ V_{02}^- = \frac{(1 + R_{\text{Lower}} \theta)^2}{\mu_t R_{\text{Lower}} \theta (\lambda_1 + \theta \lambda_2)} + \frac{(1 + \theta)\varphi}{\theta} \]

\[ V_{02}^+ = \frac{(1 + R_{\text{Upper}} \theta)^2}{\mu_t R_{\text{Upper}} \theta (\lambda_1 + \theta \lambda_2)} + \frac{(1 + \theta)\varphi}{\theta} \]

**\( V_0 \) Calculation Method 3** (restricted maximum likelihood estimation)

\[ V_{03}^- = \frac{2a}{\mu_t \left( -b - \sqrt{b^2 - 4ac} \right)} \left( 1 + \frac{1}{\theta R_{\text{Lower}}} \right) + \frac{(1 + \theta)\varphi}{\theta} \]

where

\[ a = -\varphi \mu_t R_{\text{Lower}} (1 + \theta), \]

\[ b = \varphi \mu_t (\lambda_1 R_{\text{Lower}} + \theta \lambda_2) - (1 + \theta R_{\text{Lower}}), \]

\[ c = \lambda_1 + \theta \lambda_2 \]

\( V_{03}^- \) is calculated in the same way, replacing \( R_{\text{Lower}} \) with \( R_{\text{Upper}} \).
Zhu (2016) did not give a recommendation regarding whether Method 1, 2, or 3 should be used, except to say that “in summary, based on scenarios simulated, all of the sample size methods derived in this paper calculated reasonably accurate sample sizes for the intended power. Although some methods seemed slightly better than the others for some scenarios, the sample size differences were very small relative to the actual sample sizes.”

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains the parameters associated with this test such as the Negative Binomial rates, sample sizes, alpha, and power.

**Solve For**

**Solve For**

This option specifies the parameter to be solved for from the other parameters.

**Variance Calculation**

**Variance Calculation Method**

Select among the three methods for calculating the V0 variance component (see the documentation above for details).

- **Using Assumed True Rates**
  
  For this choice, the variance component V0 is based the values entered for λ1 and λ2.

- **Fixed Marginal Total**
  
  This method assumes a fixed number of events.

- **Restricted Maximum Likelihood Estimation**
  
  This method uses the variance calculation based on restricted maximum likelihood estimation.

**Power and Alpha**

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of inferiority when in fact the treatment mean is non-inferior.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

**Alpha**

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when rejecting the null hypothesis of inferiority when in fact the treatment group is not inferior to the reference group.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

μ(t) (Average Exposure Time)

μ(t) (Average Exposure Time)
Enter a value (or range of values) for the average exposure (observation) time for each subject in each group. A value of one is commonly entered when exposure times are all equal. The range is μ(t) > 0. You can enter a single value such as 0.8 0.9 1 or 0.8 to 1.2 by 0.1.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on N1 or N2 or both.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter N2, solve for N1**
  Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

- **Enter R = N2/N1, solve for N1 and N2**
  For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is

  \[ N2 = R \times N1. \]

- **Enter percentage in Group 1, solve for N1 and N2**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”

N2 is the number of items or individuals sampled from the Group 2 population.

N2 must be ≥ 2. You can enter a single value or a series of values.

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1}. \]

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.
Equivalence Tests for the Ratio of Two Negative Binomial Rates

N2 is related to N1 by the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \([Y]\) is the next integer \(\geq Y\).

For example, setting \(R = 2.0\) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \(N1 = 10\) and \(N2 = 20\), or \(N1 = 50\) and \(N2 = 100\)).

\(R\) must be greater than 0. If \(R < 1\), then \(N2\) will be less than \(N1\); if \(R > 1\), then \(N2\) will be greater than \(N1\). You can enter a single or a series of values.

**Percent in Group 1**

*This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”*

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for \(N1\) and \(N2\). Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

---

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (N1 = N2)**
  
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter N1 and N2 individually**
  
  This choice permits you to enter different values for \(N1\) and \(N2\).

- **Enter N1 and R, where N2 = R * N1**
  
  Choose this option to specify a value (or values) for \(N1\), and obtain \(N2\) as a ratio (multiple) of \(N1\).

- **Enter total sample size and percentage in Group 1**
  
  Choose this option to specify a value (or values) for the total sample size (\(N\)), obtain \(N1\) as a percentage of \(N\), and then \(N2\) as \(N - N1\).

**Sample Size Per Group**

*This option is displayed only if Group Allocation = “Equal (N1 = N2).”*

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for \(N1\), and also the value for \(N2\).

The Sample Size Per Group must be \(\geq 2\). You can enter a single value or a series of values.

**N1 (Sample Size, Group 1)**

*This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = R * N1.”*

\(N1\) is the number of items or individuals sampled from the Group 1 population.

\(N1\) must be \(\geq 2\). You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”

N2 is the number of items or individuals sampled from the Group 2 population. N2 must be ≥ 2. You can enter a single value or a series of values.

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”

R is the ratio of N2 to N1. That is, 
\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
\[ N2 = \lceil R \times N1 \rceil, \]

where the value \([Y]\) is the next integer ≥ \(Y\).

For example, setting \(R = 2.0\) results in a Group 2 sample size that is double the sample size in Group 1.

R must be greater than 0. If \(R < 1\), then N2 will be less than N1; if \(R > 1\), then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

Effect Size

RU (Upper Equivalence Limit)
Enter the upper equivalence limit for the ratio of the two Negative Binomial event rates (\(\lambda_2 / \lambda_1\)). This value is entered as a ratio, not a percentage. When the ratio of the Negative Binomial event rates is between this value and RL, the two rates are said to be 'equivalent'. This value must be greater than one. Common choices are 1.1, 1.2, 1.25, and 1/RL. If you enter '1/RL', RU will be calculated from RL as \(RU = 1/RL\). The choice '1/RL' is popular because RL and RU = 1/RL are limits that are of equal magnitude on the log scale.
**RL (Lower Equivalence Limit)**
Enter the lower equivalence limit for the ratio of the two Negative Binomial event rates ($\lambda_2 / \lambda_1$). This value is entered as a ratio, not a percentage. When the ratio of the Negative Binomial event rates is between this value and RU, the two rates are said to be 'equivalent'. This value must be less than one. Common choices are 0.8, 0.9, and 1/RU. If you enter '1/RU', RL will be calculated from RU as $RL = 1/RU$. The choice '1/RU' is popular because RU and RL = 1/RU are limits that are of equal magnitude on the log scale.

**$\lambda_1$ (Event Rate of Group 1)**
Enter a value (or range of values) for the mean event rate per time unit in group 1 (control).

**Example of Estimating $\lambda_1$**
If 200 patients were exposed for 1 year (i.e. $t_1 = 1$ year) and 40 experienced the event of interest, then the mean event rate would be $\lambda_1 = 40/(200*1) = 0.2$ per patient-year. If 200 patients were exposed for 2 years (i.e. $t_1 = 2$ years) and 40 experienced the event of interest, then the mean event rate would be $\lambda_1 = 40/(200*2) = 0.1$ per patient-year.

$\lambda_1$ is used with $\lambda_2$ to calculate the event rate ratio as $\lambda_2 / \lambda_1$. The range is $\lambda_1 > 0$. You can enter a single value such as 1 or a series of values such as 1 1.2 1.4 or 1 to 2 by 0.5.

**Enter $\lambda_2$ or Ratio for Group 2**
Indicate whether to enter the Group 2 event rate ($\lambda_2$) directly or the event rate ratio ($\lambda_2 / \lambda_1$) to specify $\lambda_2$. The event rate ratio is calculated from $\lambda_2$ and $\lambda_1$ as $\lambda_2 / \lambda_1$.

**$\lambda_2$ (Event Rate of Group 2)**
Enter a value (or range of values) for the mean event rate per time unit in group 2 (treatment).

**Example of Estimating $\lambda_2$**
If 200 patients were exposed for 1 year (i.e. $t_1 = 1$ year) and 40 experienced the event of interest, then the mean event rate would be $\lambda_2 = 40/(200*1) = 0.2$ per patient-year. If 200 patients were exposed for 2 years (i.e. $t_1 = 2$ years) and 40 experienced the event of interest, then the mean event rate would be $\lambda_2 = 40/(200*2) = 0.1$ per patient-year.

$\lambda_1$ is used with $\lambda_2$ to calculate the event rate ratio as $\lambda_2 / \lambda_1$. The range is $\lambda_2 > 0$. You can enter a single value such as 1 or a series of values such as 1 1.2 1.4 or 1 to 2 by 0.5.

**$\lambda_2 / \lambda_1$ (Ratio of Event Rates)**
This is the (assumed, known, true) value of the ratio of the two event rates, $\lambda_1$ and $\lambda_2$, at which the power is to be calculated. The event rate ratio is calculated from $\lambda_1$ and $\lambda_2$ as $\lambda_2 / \lambda_1$. The range is $\lambda_2 / \lambda_1 > 0$ and $RL < \lambda_2 / \lambda_1 < RU$. You can enter a single value such as 1 or a series of values such as 0.9 0.95 1 1.05 1.1 or 0.9 to 1.1 by 0.05.

**$\varphi$ (Dispersion)**
Enter a value or series of values for the anticipated Negative Binomial dispersion. You can enter a single value such as 0.4 or a series of values such as 0.2 0.3 0.4 0.5 or 0.2 to 0.5 by 0.1.
Example 1 – Calculating Sample Size

Researchers wish to determine whether the average Negative Binomial rate of those receiving a new treatment is equivalent to a current control. The average exposure time for all subjects is 1.6 years. The two treatments will be considered equivalent if the event rate ratio is between 0.8 and 1.25. The event rate of the control group is 2.2 events per year. The researchers would like to examine the effect on sample size of a range of treatment group event rates from 1.9 to 2.5. Dispersion values ranging from 0.2 to 0.5 will be considered.

The desired power is 0.9 and the significance level will be 0.025. The variance calculation method used will be the method where the assumed rates are used.

Setup

This section presents the values of each of the parameters needed to run this example. First load the Equivalence Tests for the Ratio of Two Negative Binomial Rates procedure window from the menus. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Variance Calculation Method</td>
<td>Using Assumed True Rates</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>( \mu(t) ) (Average Exposure Time)</td>
<td>1.6</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>RU (Upper Equivalence Limit)</td>
<td>1.25</td>
</tr>
<tr>
<td>RL (Lower Equivalence Limit)</td>
<td>0.8</td>
</tr>
<tr>
<td>( \lambda_1 ) (Event Rate of Group 1)</td>
<td>2.2</td>
</tr>
<tr>
<td>Enter ( \lambda_2 ) or Ratio for Group 2</td>
<td>( \lambda_2 ) (Event Rate of Group 2)</td>
</tr>
<tr>
<td>( \lambda_2 ) (Event Rate of Group 2)</td>
<td>1.9 to 2.5 by 0.1</td>
</tr>
<tr>
<td>( \varphi ) (Dispersion)</td>
<td>0.2 to 0.5 by 0.05</td>
</tr>
</tbody>
</table>
Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>μ(t)</th>
<th>Grp 1 Event Rate</th>
<th>Grp 2 Event Rate</th>
<th>Lower Equiv. Limit</th>
<th>Upper Equiv. Limit</th>
<th>Dispersion</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90001</td>
<td>1817</td>
<td>1817</td>
<td>3634</td>
<td>1.60</td>
<td>2.20</td>
<td>1.90</td>
<td>0.864</td>
<td>0.800</td>
<td>1.250</td>
<td>0.20</td>
</tr>
<tr>
<td>0.90009</td>
<td>641</td>
<td>641</td>
<td>1282</td>
<td>1.60</td>
<td>2.20</td>
<td>2.00</td>
<td>0.909</td>
<td>0.800</td>
<td>1.250</td>
<td>0.20</td>
</tr>
<tr>
<td>0.90067</td>
<td>333</td>
<td>333</td>
<td>666</td>
<td>1.60</td>
<td>2.20</td>
<td>2.10</td>
<td>0.955</td>
<td>0.800</td>
<td>1.250</td>
<td>0.20</td>
</tr>
<tr>
<td>0.90048</td>
<td>253</td>
<td>253</td>
<td>506</td>
<td>1.60</td>
<td>2.20</td>
<td>2.20</td>
<td>1.000</td>
<td>0.800</td>
<td>1.250</td>
<td>0.20</td>
</tr>
<tr>
<td>0.90042</td>
<td>317</td>
<td>317</td>
<td>634</td>
<td>1.60</td>
<td>2.20</td>
<td>2.30</td>
<td>1.045</td>
<td>0.800</td>
<td>1.250</td>
<td>0.20</td>
</tr>
<tr>
<td>0.90025</td>
<td>536</td>
<td>536</td>
<td>1072</td>
<td>1.60</td>
<td>2.20</td>
<td>2.40</td>
<td>1.091</td>
<td>0.800</td>
<td>1.250</td>
<td>0.20</td>
</tr>
<tr>
<td>0.90014</td>
<td>1081</td>
<td>1081</td>
<td>2162</td>
<td>1.60</td>
<td>2.20</td>
<td>2.50</td>
<td>1.136</td>
<td>0.800</td>
<td>1.250</td>
<td>0.20</td>
</tr>
<tr>
<td>0.90010</td>
<td>1997</td>
<td>1997</td>
<td>3994</td>
<td>1.60</td>
<td>2.20</td>
<td>2.60</td>
<td>0.909</td>
<td>0.800</td>
<td>1.250</td>
<td>0.25</td>
</tr>
<tr>
<td>0.90036</td>
<td>706</td>
<td>706</td>
<td>1412</td>
<td>1.60</td>
<td>2.20</td>
<td>2.00</td>
<td>0.955</td>
<td>0.800</td>
<td>1.250</td>
<td>0.25</td>
</tr>
<tr>
<td>0.90074</td>
<td>367</td>
<td>367</td>
<td>734</td>
<td>1.60</td>
<td>2.20</td>
<td>2.10</td>
<td>1.091</td>
<td>0.800</td>
<td>1.250</td>
<td>0.25</td>
</tr>
</tbody>
</table>

References

Zhu, H. 2016. 'Sample Size Calculation for Comparing Two Poisson or Negative Binomial Rates in Non-Inferiority or Equivalence Trials.' Statistics in Biopharmaceutical Research, Accepted Manuscript.

Report Definitions

Power is the probability of rejecting the null hypothesis when it is false.
N1 and N2 are the number of subjects in groups 1 and 2, respectively.
N is the total sample size. N = N1 + N2.
μ(t) is the average exposure (observation) time across subjects in both groups.
λ1 is the event rate per time unit in Group 1 (control).
λ2 is the event rate per time unit in Group 2 (treatment).
λ2 / λ1 is the (known, true, assumed) ratio of the two event rates.
Dispersion (φ) is the Negative Binomial dispersion parameter.
Alpha is the probability of rejecting the null hypothesis when it is true.

Summary Statements

For an equivalence test of H0: λ2 / λ1 ≤ 0.800 or λ2 / λ1 ≥ 1.250 vs. H1: 0.800 < λ2 / λ1 < 1.250, and using the variance calculation method with assumed true rates, samples of 1817 and 1817 subjects with average exposure time 1.60 achieve 90.001% power to detect an event rate ratio λ2 / λ1 of 0.864 when the event rate in group 1 (λ1) is 2.20, the event rate in group 2 (λ2) is 1.90, the Negative Binomial dispersion is 0.20, and the significance level (alpha) is 0.025.
## Equivalence Tests for the Ratio of Two Negative Binomial Rates

### Dropout-Inflated Sample Size

<table>
<thead>
<tr>
<th>Dropout Rate</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>N1'</th>
<th>N2'</th>
<th>N'</th>
<th>D1</th>
<th>D2</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>20%</td>
<td>1817</td>
<td>1817</td>
<td>3634</td>
<td>2272</td>
<td>2272</td>
<td>4544</td>
<td>455</td>
<td>455</td>
<td>910</td>
</tr>
<tr>
<td>20%</td>
<td>641</td>
<td>641</td>
<td>1282</td>
<td>802</td>
<td>802</td>
<td>1604</td>
<td>161</td>
<td>161</td>
<td>322</td>
</tr>
<tr>
<td>20%</td>
<td>333</td>
<td>333</td>
<td>666</td>
<td>417</td>
<td>417</td>
<td>834</td>
<td>84</td>
<td>84</td>
<td>168</td>
</tr>
<tr>
<td>20%</td>
<td>253</td>
<td>253</td>
<td>506</td>
<td>317</td>
<td>317</td>
<td>634</td>
<td>64</td>
<td>64</td>
<td>128</td>
</tr>
<tr>
<td>20%</td>
<td>317</td>
<td>317</td>
<td>634</td>
<td>397</td>
<td>397</td>
<td>794</td>
<td>80</td>
<td>80</td>
<td>160</td>
</tr>
<tr>
<td>20%</td>
<td>536</td>
<td>536</td>
<td>1072</td>
<td>670</td>
<td>670</td>
<td>1340</td>
<td>134</td>
<td>134</td>
<td>268</td>
</tr>
<tr>
<td>20%</td>
<td>1081</td>
<td>1081</td>
<td>2162</td>
<td>1352</td>
<td>1352</td>
<td>2704</td>
<td>271</td>
<td>271</td>
<td>542</td>
</tr>
<tr>
<td>20%</td>
<td>1997</td>
<td>1997</td>
<td>3994</td>
<td>2497</td>
<td>2497</td>
<td>4994</td>
<td>500</td>
<td>500</td>
<td>1000</td>
</tr>
<tr>
<td>20%</td>
<td>706</td>
<td>706</td>
<td>1412</td>
<td>883</td>
<td>883</td>
<td>1766</td>
<td>177</td>
<td>177</td>
<td>354</td>
</tr>
<tr>
<td>20%</td>
<td>367</td>
<td>367</td>
<td>734</td>
<td>459</td>
<td>459</td>
<td>918</td>
<td>92</td>
<td>92</td>
<td>184</td>
</tr>
</tbody>
</table>

### Definitions

**Dropout Rate (DR)** is the percentage of subjects (or items) that are expected to be lost at random during the course of the study and for whom no response data will be collected (i.e. will be treated as "missing").

N1, N2, and N are the evaluable sample sizes at which power is computed. If N1 and N2 subjects are evaluated out of the N1' and N2' subjects that are enrolled in the study, the design will achieve the stated power.

N1', N2', and N' are the number of subjects that should be enrolled in the study in order to end up with N1, N2, and N evaluable subjects, based on the assumed dropout rate. After solving for N1 and N2, N1' and N2' are calculated by inflating N1 and N2 using the formulas N1' = N1 / (1 - DR) and N2' = N2 / (1 - DR), with N1' and N2' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J., and Wang, H. (2008) pages 39-40.)

D1, D2, and D are the expected number of dropouts. D1 = N1' - N1, D2 = N2' - N2, and D = D1 + D2.

This report shows the sample sizes for the indicated scenarios.
Plots Section

These plots represent the required sample sizes for various values of $\lambda_2$ and the dispersion parameter.
Example 2 – Validation using Zhu (2016)

Zhu (2016) presents an example of solving for sample size where the event rates are both 2.5, the dispersion parameter is 0.35, the average duration is 0.9, the equivalence limits are 0.875 and 1.14 (1 / 0.875), the power is 0.9, and the Type I error rate is 0.05.

The calculated total sample sizes are 965, 966, and 966 for the Assumed True Rate, and Fixed Marginal Total, and REML variance calculation methods, respectively.

Setup

This section presents the values of each of the parameters needed to run this example. First load the Equivalence Tests for the Ratio of Two Negative Binomial Rates procedure window from the menus. You may then make the appropriate entries as listed below, or open Example 2 (a, b, or c) by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Variance Calculation Method</td>
<td>Using Assumed True Rates (2nd run: Fixed Marginal Total 3rd run: Restricted Maximum Likelihood Estimation)</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>μ(t) (Average Exposure Time)</td>
<td>0.9</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>RU (Upper Equivalence Limit)</td>
<td>1/RL</td>
</tr>
<tr>
<td>RL (Lower Equivalence Limit)</td>
<td>0.875</td>
</tr>
<tr>
<td>λ1 (Event Rate of Group 1)</td>
<td>2.5</td>
</tr>
<tr>
<td>Enter λ2 or Ratio for Group 2</td>
<td>λ2 / λ1 (Ratio of Event Rates)</td>
</tr>
<tr>
<td>λ2 / λ1 (Ratio of Event Rates)</td>
<td>1</td>
</tr>
<tr>
<td>φ (Dispersion)</td>
<td>0.35</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Average Exposure Time</th>
<th>Grp 1 Cntrl Event Rate</th>
<th>Grp 2 Trt Event Rate</th>
<th>Event Rate Ratio</th>
<th>Lower Equiv. Limit</th>
<th>Upper Equiv. Limit</th>
<th>Dispersion</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>μ(t)</td>
<td>λ1</td>
<td>λ2</td>
<td>λ1</td>
<td>λ2</td>
<td>RL</td>
<td>RU</td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>Power</td>
<td>N1</td>
<td>N2</td>
<td>N</td>
<td>N1</td>
<td>N2</td>
<td>N</td>
</tr>
<tr>
<td>RL</td>
<td>RU</td>
<td>φ</td>
<td>Alpha</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90015</td>
<td>Fixed Marginal Total or REML</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90034</td>
<td>Restricted Maximum Likelihood Estimation</td>
<td>0.90022</td>
<td>966</td>
<td>966</td>
<td>1932</td>
<td>0.90</td>
<td>2.50</td>
</tr>
</tbody>
</table>

The sample sizes calculated in PASS match those of Zhu (2016) exactly.